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Configuration de l’OmniScan pour l’inspection de 
soudures avec le scanner COBRA 

Ce document explique comment configurer et utiliser rapidement l’appareil 
OmniScan pour effectuer une inspection de soudures à l’aide du scanner COBRA. Ce 
document contient les procédures nécessaires pour préparer une inspection, pour 
effectuer cette inspection, pour effectuer l’analyse des données et pour produire un 
rapport.

Figure 1  Appareil OmniScan MX et scanner COBRA
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Matériel et logiciel requis

Les procédures présentées dans ce document concernent l’inspection de soudures à 
l’aide du scanner COBRA et de traducteurs 7.5CCEV35-A15.

L’inspection de soudure donnée en exemple dans ces procédures est effectuée sur un 
tuyau en acier doux d’une épaisseur de 14 mm. Vous pouvez facilement adapter ces 
procédures à votre plan d’inspection de tuyaux en changeant les valeurs de quelques 
paramètres.

Vous avez besoin des éléments suivants pour exécuter les procédures contenues dans 
ce document :

• Un scanner COBRA (y compris deux traducteurs multiéléments 7.5CCEV35-A15)
• Un adaptateur en Y (réf. : OMNI-A-ADP05) pour connecter deux traducteurs 

multiéléments à l’OmniScan
• Un appareil OmniScan MX équipé d’un module multiélément 16:128 ou 32: 128

 (réf. : OMNI-P-PA16128 ou OMNI-P-PA32128)
• Le logiciel OmniScan MXU 2.0 et l’option Multigroupe

(réf. : OMNI-SO-MGROUP) et un sabot mis à jour
• Une pompe à eau manuelle (WTR-SPRAYER-4L ou 8L) pour l’irrigation

Documents connexes

Pour plus d’informations concernant le scanner COBRA, l’OmniScan et le logiciel 
OmniScan, consultez les documents suivants :

• Scanner COBRA : Manuel de l’utilisateur (réf. : DMTA-20006-01FR)
• Logiciel OmniScan MXU : Manuel de l’utilisateur (P/N: DMTA011-01FR)
• OmniScan MX : Manuel de l’utilisateur (réf.: DMTA071-01FR)
6    Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA

 



DMTA-20009-01FR, Rév. B, Septembre 2022

DMTA-20009-01FR_rev_B.book  Page 7  Sunday, July 17, 2022  7:17 PM
Préparation d’une inspection

Après avoir défini votre plan d’inspection, suivez les procédures contenues dans cette 
section pour configurer l’appareil OmniScan pour une inspection de soudures à l’aide 
du scanner COBRA. Cette configuration nécessite de définir deux groupes, un pour 
chaque traducteur multiélément.

Suivez les procédures ci-dessous dans l’ordre où elles apparaissent :

• « Démarrage de l’OmniScan » à la page 7
• « Définition du premier groupe à l’aide de l’assistant Groupe » à la page 8
• « Calcul des lois focales à l’aide de l’assistant Loi focale » à la page 11
• « Étalonnage de l’OmniScan avec l’assistant Étalonnage » à la page 12
• « Configuration des divers paramètres » à la page 13
• « Configuration du second groupe pour le second traducteur » à la page 15

Pour réduire le temps d’installation, chargez un fichier de configuration OmniScan 
pour le scanner COBRA que vous avez créé pour une inspection semblable, et puis 
effectuez les modifications nécessaires. 

Appuyez sur  ou choisissez Fichier > Fichier > Ouvrir pour ouvrir un fichier de 
configuration existant.

Démarrage de l’OmniScan

La procédure suivante décrit comment démarrer l’appareil OmniScan avec le logiciel 
OmniScan MXU 2.0 et vérifier si les composants requis sont installés.

Pour démarrer l’OmniScan

1. Assurez-vous que la carte de stockage de l’OmniScan contient le logiciel 
OmniScan MXU 2.0.

2. Pour vous assurer d’avoir la définition de traducteur et de sabot du scanner 
COBRA sur la carte de mémoire :
Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA    7
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a) Rendez-vous à la section de téléchargement des logiciels sur le site Web 
d’Evident (EvidentScientific.com) et téléchargez la dernière mise à jour de 
sabot ;

b) Enregistrez la mise à jour de sabot sur la carte de mémoire OmniScan.
3. Insérez la carte de mémoire dans l’OmniScan.
4. Connectez le traducteur multiélément situé sur le côté codeur du scanner au 

connecteur P1 (canaux 1 à 64) de l’adaptateur en Y. 
5. Connectez l’autre traducteur multiélément à l’autre connecteur de l’adaptateur 

en Y.
6. Connectez l’adaptateur en Y à l’appareil OmniScan MX.

7. Démarrez l’OmniScan en appuyant sur le bouton de mise en marche ( ) situé 
dans le coin inférieur droit du panneau frontal de l’appareil. L’appareil affiche le 
logo OmniScan.

8. Si la carte de mémoire contient plus d’une application, un écran présente les 
boutons correspondant aux applications pour que vous puissiez choisir celle que 
vous souhaitez démarrer. Sélectionnez OmniScan [MXU - 2.0]. Le logiciel 
OmniScan MXU démarre.

9. Pour vérifier si l’option logicielle Multigroupe est installée :
a) Sélectionnez Préférences > Service > Info système.
b) Dans le rapport Système OmniScan MX qui s’affiche, sélectionnez la section 

Module d’acquisition à l’aide de la roulette de défilement.
c) Vérifiez que la réponse Oui s’affiche dans la colonne En fonction de l’option 

Multigroupe en fonction [OMNI-SO-MGROUP].
d) Choisissez Fermer pour fermer le rapport.

10. Si l’option Multigroupe n’est pas activée, veuillez contacter Evident pour l’achat 
de l’option.

Définition du premier groupe à l’aide de l’assistant Groupe

La procédure suivante décrit comment mettre en place le groupe du premier 
traducteur multiélément du scanner COBRA (situé sur le côté codeur du scanner) en 
utilisant l’assistant Groupe.
8    Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA
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Pour définir le premier groupe à l’aide de l’assistant Groupe

1. Dans l’OmniScan, sélectionnez Assistant > Groupe > Démarrer pour définir la 
configuration. La première étape de l’assistant s’affiche et vous indique comment 
procéder à l’ étape Sélect. opération (voir la Figure 2 à la page 9).

Figure 2  Étape Sélect. opération de l’assistant Groupe

Appuyez sur la touche Annuler ( ) plusieurs fois si vous souhaitez quitter 
l’assistant.
Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA    9
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2. À l’étape Sélect. opération, sélectionnez Opération = Modifier, et puis choisissez 
Suivant.

3. À l’étape Valider le matériau :
a) Sélectionnez Forme = Plaque.
b) Choisissez Épaisseur et, conformément à votre plan d’inspection, entrez 

l’épaisseur du nombre de bonds nécessaires pour couvrir l’ensemble de la 
soudure. Dans cet exemple, deux temps de bonds de 14 mm équivalent à 
28 mm.

Entrez de nouveau l’épaisseur réelle du tuyau inspecté après l’étalonnage.

c) Sélectionnez Matériau = Acier doux, et puis sélectionnez Suivant. Modifiez 
cette sélection en fonction du tuyau que vous inspectez.

4. À l’étape Sélect. type groupe, sélectionnez Mode gr. = PA, et puis sélectionnez 
Suivant.

5. À l’étape Sélect. connexion, la Connexion É du premier groupe est toujours 
réglée à 1. Sélectionnez Suivant.

6. À l’étape Sélect. traducteur :
a) Sélectionnez Sélection = Sélect. Tx/Rx.
b) Sélectionnez Autodétection = Désactivée.
c) Sélectionnez Traducteur.
d) Dans la boîte de dialogue qui s’affiche, sélectionnez A15 dans la liste de 

gauche, 7.5L16-A15 dans la liste de droite, et puis choisissez Sélection pour 
fermer la boîte de dialogue.

e) Sélectionnez Suivant.
7. À l’étape Sélect. sabot :

a) Sélectionnez Sélection  = Tx/Rx.
b) Sélectionnez Sabot.
c) Dans la boîte de dialogue qui s’affiche, sélectionnez SA15 dans la liste de 

gauche, SA15-N60S-IH dans la liste de droite, et puis choisissez Sélection 
pour fermer la boîte de dialogue.

d) Sélectionnez Suivant.
8. À l’étape Régler la position :

a) Entrez Décal. balay. = 0 mm.
10    Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA
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b) Dans cet exemple, entrez Décal. index = –22 mm. Modifiez cette valeur en 
fonction du tuyau que vous inspectez.

c) Entrez Bigle (°) = 90, et puis sélectionnez Suivant.
9. À l’étape Accepter, sélectionnez Terminer pour fermer l’assistant Groupe.
10. Enregistrez votre configuration (format .ops) comme suit :

a) Sélectionnez Fichier  > Enr. conf. sous.
b) Dans le gestionnaire de fichiers qui s’affiche, sélectionnez un fichier de 

configuration.
OU
Sélectionnez Nom de fichier, et puis entrez le nom de fichier désiré.

c) Sélectionnez Enregistrer pour enregistrer le fichier et fermer le gestionnaire 
de fichiers.

Le fichier s’enregistre sur la carte de mémoire dans le dossier \User\Setup.

Calcul des lois focales à l’aide de l’assistant Loi focale

Une fois que le groupe est défini, calculez les lois focales pour le premier traducteur 
multiélément du scanner COBRA à l’aide de l’assistant Loi focale.

Pour calculer les lois focales à l’aide de l’assistant Loi focale

1. Sélectionnez Assistant > Loi focale, et puis sélectionnez Départ à l’étape 
Assistant de loi.

2. À l’étape Sélect. configuration de loi, sélectionnez Config. loi = Sectorielle, et 
puis sélectionnez Suivant.

3. À l’étape Régler le type d’onde, sélectionnez Type d’onde = OT, et puis 
sélectionnez Suivant.

4. À l’étape Sélection des éléments du traducteur :
a) Entrez Qté d’élém. = 16.
b) Entrez Premier élém. = 1, et puis sélectionnez Suivant.

5. À l’étape Régler l’angle du faisceau, réglez les paramètres qui suivent en fonction 
de votre plan d’inspection. Dans cet exemple :
a) Entrez Angle min. = 40°. 
b) Entrez Angle max. = 70°. 
c) Entrez Pas de l’angle = 0,5. Augmentez cette valeur lorsque vous utilisez des 

vitesses de balayage plus rapides.
Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA    11
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d) Entrez Prof. focale = 28 mm (comme à l’étape 3.b dans la section « Définition 
du premier groupe à l’aide de l’assistant Groupe » à la page 8).

e) Sélectionnez Suivant.
6. À l’étape Générer la loi, sélectionnez Générer.
7. Sélectionnez Fichier > Enregistrer la configuration sous pour enregistrer votre 

configuration.

Étalonnage de l’OmniScan avec l’assistant Étalonnage

Une fois que vous avez défini le groupe et que vous avez calculé les lois focales, vous 
devez maintenant étalonner la sensibilité de l’appareil, la vitesse des ultrasons et le 
délai du sabot, et définir une courbe de mesure. Vous pouvez faire cela rapidement à 
l’aide de l’assistant Étalonnage.

Voir le Logiciel OmniScan MXU : Manuel de l’utilisateur (P/N: DMTA011-01FR) pour 
plus de détails sur les procédures d’étalonnage.

Pour étalonner l’OmniScan à l’aide de l’assistant Étalonnage

1. Retirez l’ensemble traducteur-sabot qui se trouve du côté codeur du scanner.

2. Appuyez sur la touche Étalonnage ( ).
OU
Sélectionnez Assistant > Étalonnage pour accéder à l’étape Sélect. l’étalonnage.

3. Étalonnez la vitesse de propagation de l’onde ultrasons dans le matériau du tuyau 
inspecté :
a) Sélectionnez Type = Ultrasons.
b) Sélectionnez Mode = Vitesse.
c) Sélectionnez Départ et suivez les étapes de l’assistant.

4. Étalonnez le délai de la vitesse de propagation dans le matériau du sabot : 
a) Sélectionnez Type = Ultrasons.
b) Sélectionnez Mode = Délai du sabot.
c) Sélectionnez Départ et suivez les étapes de l’assistant.

5. Étalonnez la sensibilité de l’appareil pour vous assurer de détecter un petit 
réflecteur de référence :
a) Sélectionnez Type = Ultrasons.
b) Sélectionnez Mode = Sensibilité.
c) Sélectionnez Départ et suivez les étapes de l’assistant.
12    Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA
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6. Définition d’une courbe de mesure
a) Sélectionnez Type = Ultrasons.
b) Sélectionnez TCG (gain corrigé en fonction du temps) et effectuez 

l’étalonnage de façon à couvrir la profondeur des réflecteurs rencontrés lors 
de l’inspection.

7. Sélectionnez Fichier > Enr. conf. sous pour enregistrer votre configuration.

Configuration des divers paramètres

Lorsque vous avez complété les étapes de l’assistant, vous devez configurer d’autres 
paramètres tels que les paramètres des ultrasons, des portes, de l’affichage, de la 
pièce, du balayage et du codeur.

Pour configurer divers paramètres

1. Entrez Trad./Pièce > Pièces > Épaisseur = 14 mm, l’épaisseur réelle du tuyau dans 
cet exemple.
Adaptez cette valeur à l’épaisseur réelle du tuyau inspecté. 

2. Sélectionnez Réglages UT > Général, ou appuyez sur la touche de raccourci 
correspondante pour vérifier les autres réglages :

a) Entrez Gain = 18,4 ( ).

b) Entrez Départ = 0 ( ).

c) Entrez Étendue = 50 ( ) pour couvrir l’épaisseur de toutes les lois focales.
d) Entrez Délai du sabot = 0.

3. Sélectionnez Réglage UT > Émetteur :
a) Sélectionnez Tension = Haut.
b) Sélectionnez Larg. imp. = Auto.
c) Sélectionnez PRF = Optimum.

4. Sélectionnez Réglages UT > Récepteur :
a) Sélectionnez Filtre = 7,5 MHz.
b) Sélectionnez Redresseur = Pleine onde.
c) Sélectionnez Filtre vidéo = Activé.
d) Entrez Moyennage = 1.
Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA    13
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5. Sélectionnez Porte/Alarme > Porte ou appuyez sur  pour régler les 
paramètres des portes :
a) Sélectionnez Paramètres = Position.
b) Sélectionnez Porte = A, et puis réglez les paramètres de la porte afin que la 

porte A couvre toute la section inspectée, conformément au plan d’inspection 
(deux bonds équivalent à deux fois l’épaisseur). Dans cet exemple :
(1) Entrez Départ = 3 mm.
(2) Entrez Largeur = 30 mm.
(3) Entrez Seuil = 25 %.

c) Sélectionnez Porte = B, et puis réglez les paramètres des portes afin que la 
porte B couvre le milieu de la soudure, sans détecter les réflecteurs de 
géométrie. Dans cet exemple :
(1) Entrez Départ = 16 mm.
(2) Entrez Largeur = 10 mm.
(3) Entrez Seuil = 10 %.

d) Sélectionnez Porte = I, et puis réglez les paramètres de la porte de façon à 
masquer la porte I:
(1) Entrez Départ = 0 mm.
(2) Entrez Largeur = 0,05 mm.
(3) Entrez Seuil = 10 %. 

6. Sélectionnez Affichage > Superposition :
a) Sélectionnez Unité UT = Profond. réelle.
b) Sélectionnez Grille = Désactivé.
c) Sélectionnez Courbes de mesure = Activé.
d) Sélectionnez Porte = Activé. 
e) Sélectionnez Curseur = Activé. 
f) Sélectionnez Superposition = Activé.

7. Sélectionnez Affichage > Propriétés, sélectionnez Source = La plus élevée (%), et 
puis sélectionnez Oui dans la boîte de dialogue qui s’affiche.

8. Sélectionnez Balayage > Inspection :
a) Sélectionnez Type = Bal. une ligne.
b) Sélectionnez Balayage > Codeur 1.
c) Sélectionnez Vit. max. bal. à la valeur maximale acceptée (98 mm/s dans cet 

exemple).
14    Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA
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9. Sélectionnez Balayage > Codeur :
a) Sélectionnez Polarité = Normale.
b) Sélectionnez Type = Quad.
c) Entrez Résolution = 32 pas/mm.
d) Entrez Origine = 0.

10. Sélectionnez Balayage > Zone :
a) Entrez Départ bal. = 0 mm.
b) Entrez Fin balay. = 400 mm.

Réglez cette valeur en fonction de la circonférence du tuyau que vous 
inspectez.

c) Entrez Résolut. balay. = 1 mm. 
Le scanner COBRA permet de définir la valeur de la résolution de balayage à 
aussi peu que 1/32 mm. Cependant, une petite résolution de balayage ralentit 
l’inspection.

11. Sélectionnez Fichier > Enr. conf. sous pour enregistrer votre configuration.

Configuration du second groupe pour le second traducteur

Si vous avez effectué toutes les procédures qui précèdent, les réglages et l’étalonnage 
sont terminés pour le premier groupe, c’est-à-dire pour le traducteur qui se trouve du 
côté codeur du scanner. Vous devez maintenant configurer le second traducteur. Vous 
pouvez le faire rapidement en copiant les paramètres du premier groupe (y compris 
l’étalonnage) et en réglant quelques paramètres.

Pour configurer le second groupe pour le second traducteur

1. Sélectionnez Trad./Pièce > Sélection > Groupe = Ajouter. 
2. Dans la boîte de dialogue qui s’affiche, vous demandant si vous souhaitez copier 

les paramètres dans le groupe actuel, choisissez Oui. L’OmniScan crée le 
Groupe 2.

3. Sélectionnez Assistant > Groupe.
4. À l’étape Assistant de groupes, sélectionnez Départ.
5. À l’étape Sélect. opération, sélectionnez Opération = Modifier, et puis choisissez 

Suivant.
6. À l’étape Sélect. groupe, sélectionnez Groupe = 2, et puis sélectionnez Suivant.
7. Sélectionnez Suivant jusqu’à ce que vous atteigniez l’étape Sélect. connexion, et 

puis entrez Connexion P = 65.
Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA    15
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8. Sélectionnez Suivant jusqu’à ce que vous atteigniez l’étape Régler la position, et 
puis :
a) Dans cet exemple, entrez Décalage index = 22 mm.

Réglez cette valeur pour le tuyau que vous inspectez, selon votre plan 
d’inspection.

b) Entrez Bigle(°) = 270.
9. Sélectionnez Suivant jusqu’à ce que vous atteigniez l’étape Accepter, et puis 

sélectionnez Terminer.

10. Appuyez sur , ou sélectionnez Affichage > Sélection pour régler l’affichage :
a) Sélectionnez Affichage = A-S-(C).
b) Sélectionnez C-Scan = A %.
c) Sélectionnez Groupe = Tous.
Les deux groupes s’affichent maintenant comme le montre l’exemple de la 
Figure 3 à la page 17.
16    Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA
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Figure 3  Deux groupes affichés dans la configuration complétée

11. Sélectionnez Fichier > Enr. conf. sous pour enregistrer votre configuration.

Données du traducteur côté codeur
et groupe actuellement sélectionné Données du second groupe
Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA    17
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Réalisation de l’inspection

Lorsque la procédure de préparation est terminée (voir la section « Préparation d’une 
inspection » à la page 7), vous pouvez procéder à l’inspection de la soudure.

Pour inspecter la soudure

1. Voir Scanner COBRA : Manuel de l’utilisateur (réf. : DMTA-20006-01FR) pour plus 
de détails :
a) Configurez le scanner en fonction du diamètre du tuyau.
b) Réglez la distance entre les deux traducteurs du scanner en fonction de votre 

plan d’inspection (22 mm de chaque côté du centre de la soudure pour cet 
exemple). 

2. Installez le scanner sur le tuyau de manière à ce que la soudure soit centrée entre 
les deux traducteurs.

3. S’il y a lieu, utilisez la touche Gain ( ) pour régler le gain de sorte que la forme 
de la soudure s’affiche dans le S-scan.

4. Assurez-vous que le scanner contient du couplant.
5. Lorsque vous êtes prêt à acquérir des données dans le C-scan, appuyez sur la 

touche de départ ( ), puis faites tourner manuellement le scanner sur toute la 
circonférence. Les données acquises par chaque traducteur s’affichent dans le C-
scan.

Analyse des données

Une fois que vous avez acquis les données (voir la section « Réalisation de 
l’inspection » à la page 18), faites passer l’OmniScan en mode Analyse pour trouver et 
caractériser les indications.

Vous pouvez également utiliser le logiciel TomoView pour analyser les données 
d’inspection acquises avec l’OmniScan.
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Analyse des données avec l’OmniScan

1. Appuyez sur la touche Gel ( ) pour passer en mode Analyse. La vue de 
données se fige dans l’état actuel, et le témoin orange d’acquisition clignote (voir 
la Figure 4 à la page 19).

Figure 4  Témoin d’acquisition

2. Pour enregistrer vos données aux fins d’analyses ultérieures :
a) Sélectionnez Fichier > Fichier > Mode d’enr. = Don. insp.
b) Sélectionnez Fichier > Fichier > Nom de fichier, et puis entrez le nom 

souhaité.

Insérez le caractère « # » dans le nom de fichier pour que les chiffres s’incrémentent 
automatiquement. Par exemple, le nom Données#### deviendra Données0001, 
Données0002, etc. Voir Logiciel OmniScan MXU : Manuel de l’utilisateur (P/N: 
DMTA011-01FR) pour plus de détails sur les caractères spéciaux.

c) Sélectionnez Fichier > Fichier> Enr. données.
Le fichier s’enregistre sur la carte de mémoire dans le dossier \User\Data. 

3. Pour trouver une indication :
a) Pour sélectionner le groupe souhaité, appuyez sur la touche Sélecteur de 

groupe ( ) et gardez-la enfoncée. Le fond du A-scan non sélectionné 
s’affiche en gris (voir la Figure 7 à la page 23). 

b) Utilisez le curseur de données pour balayer les tranches d’une indication :

(1) Appuyez sur la touche Curseur ( ) ou sélectionnez Mesures > 
Curseurs > Sélection, et puis sélectionnez Données.

Le témoin d’acquisition clignote en mode
Analyse
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(2) Entrez Mesures > Curseurs > Balayage = 0 mm.
(3) Tout en regardant le S-scan et en modifiant la valeur du paramètre 

Mesures > Curseurs > Balayage, tournez la roulette de défilement vers la 
droite pour balayer les tranches de données jusqu’à ce que vous trouviez 
un réflecteur inhabituel.

4. Trouvez le signal maximal à l’aide du curseur d’angle : 
a) Choisissez Mesures > Curseurs > Angle pour sélectionner le curseur d’angle.
b) Tournez la roulette de défilement jusquʹà ce que le curseur d’angle dans le S-

scan présente un signal dʹamplitude maximum du réflecteur dans le A-scan.
5. Pour faire un zoom sur le réflecteur dans le C-scan : 

a) Sélectionnez Affichage > Zoom > Affichage = C-Scan non corrigé.
b) Réglez le paramètre Départ bal. à l’endroit où vous souhaitez que le zoom 

débute dans le C-scan.
c) Réglez le paramètre Fin balay. à l’endroit où vous souhaitez que le zoom se 

termine dans le C-scan.
6. Pour mesurer l’indication à l’aide des curseurs de référence (ligne rouge) et de 

mesure (ligne verte) [voir la Figure 5 à la page 21] :
a) Sélectionnez Affichage > Superpos. > Curseur = Activé afin de vous assurer 

que les curseurs s’affiche à l’écran.
b) Sélectionnez Affichage > Sélection > Affichage = S.
c) Sélectionnez Affichage > Zoom, et puis régler les paramètres Départ Index, 

Fin Index, Départ UT et Fin UT pour faire un zoom avant sur l’indication.
d) Sélectionnez Mesures > Curseurs > Sélection = Mesures, et puis réglez la 

position du curseur UT de chaque côté de l’indication.
e) Sélectionnez Mesures > Curseurs > Sélection = Référence, et puis réglez la 

position du curseur UT de chaque côté de l’indication.
f) Pour afficher les lectures souhaitées, sélectionnez Mesures > Lectures, et 

puis :
(1) Entrez Liste = 1.
(2) Sélectionnez Champ 1 = A%, l’amplitude maximale du signal.
(3) Sélectionnez Champ 2 = DA^, la profondeur de l’indication dans la pièce.
(4) Sélectionnez Champ 3 = ViA^, la position volumétrique de l’indication 

détectée dans la porte.
(5) Sélectionnez Champ 4 = U(m-r), la distance sur l’axe d’ultrasons obtenue 

en soustrayant la position du curseur de référence de la position du 
curseur de mesure. 
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g) Consultez les lectures au-dessus des données pour connaître la taille et la 
position de l’indication.

Il vous est possible d’afficher de nombreuses autres lectures disponibles dans 
l’OmniScan.

Figure 5  Effectuer un zoom et positionner les curseurs sur une indication

7. Pour ajouter l’indication dans la table d’indications (voir la Figure 6 à la page 22) 
a) Sélectionnez Mesures > Table > Afficher table = Activé. 

Curseur de référence
Curseur de mesure
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b) Sélectionnez Mesures > Table > Ajoutez entrée pour ajouter une indication 
dans la table d’indications.

Figure 6  Ajout dʹ une indication dans la table d’indications

8. Vous pouvez aussi mesurer la longueur de l’indication dans le C-scan :
a) Sélectionnez Affichage > Sélection > Affichage = C.

b) Appuyez sur la touche Curseur ( ).
c) Sélectionnez Mesures > Curseurs > Sélection = Mesures.
d) Sélectionnez Mesures > Curseurs > Balayage pour régler la position de 

départ sur l’axe de balayage.
e) Sélectionnez Mesures > Curseurs > Sélection = Référence.
f) Sélectionnez Mesures > Curseurs > Balayage pour régler la position de fin 

sur l’axe de balayage.
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g) Consultez les lectures au-dessus des données pour obtenir la taille et la 
position de l’indication.

9. Sélectionnez Mesures > Table > Ajoutez entrée pour ajouter une indication dans 
la table d’indications

10. Sélectionnez Mesures > Table > Afficher Table = Désactivé pour masquer la table 
d’indications.

11. Sélectionnez Affichage > Sélection > Affichage = A-S-(C) pour afficher le A-scan, 
le S-scan et le C-scan pour les deux groupes, tel que montré dans l’exemple de la 
Figure 7 à la page 23.

Figure 7  Vue du A-scan, du S-scan et du C-scan des deux groupes 
en mode Analyse

Groupe actuellement sélectionné
Configuration de l’OmniScan pour l’inspection de soudures avec le scanner COBRA    23

 



DMTA-20009-01FR, Rév. B, Septembre 2022

DMTA-20009-01FR_rev_B.book  Page 24  Sunday, July 17, 2022  7:17 PM
Production d’un rapport

Le logiciel OmniScan MXU permet de produire facilement des rapports d’inspection. 
Les rapports peuvent être configurés, produits, révisés, imprimés et enregistrés à 
partir de l’OmniScan. Les rapports sont enregistrés en format HTML. 

Le rapport peut inclure un en-tête, jusqu’à dix champs d’information utilisateurs, des 
paramètres de caractérisation du traducteur, des paramètres de configuration, des 
notes utilisateurs, une vue de la disposition et le contenu de la table d’indication. 

Pour produire un rapport

1. En mode Analyse, sélectionnez Fichier > Format et sélectionnez les éléments que 
vous souhaitez inclure au rapport :
a) Sélectionnez Fichier > Format > Champ util. = Activé pour inclure les 

informations des champs utilisateurs.
b) Sélectionnez Fichier > Format > Traducteur = Activé pour inclure les 

paramètres du traducteur.
c) Sélectionnez Fichier > Format > Configuration = Activé pour inclure les 

paramètres de configuration.
d) Sélectionnez Fichier > Format > Note = Activé pour inclure les notes.
e) Sélectionnez Fichier > Format > Vue = Aff. courant pour inclure une image de 

l’affichage de données courant. 
OU
Sélectionnez Table pour inclure plutôt le contenu de la table d’indication.
OU
Sélectionnez Désactivé pour n’en inclure aucun.

2. Si vous avez inclus les champs utilisateurs, définissez-les comme suit :
a) Sélectionnez Fichier > Champ utilisateur > Sélectionner, et puis sélectionnez 

le chiffre correspondant à l’un des dix champs utilisateurs disponibles.
b) Sélectionnez Fichier > Champ util. > Activer = Activé.
c) Sélectionnez Fichier > Champ util. > Étiquette, et puis entrez le texte de ce 

champ (par exemple : Inspecteur).
d) Sélectionnez Fichier > Champ util. > Contenu, et puis entrez le texte de ce 

champ (par exemple : <votre nom>).
e) Répétez les étapes 2.a à 2.d pour les autres champs. 

3. Si vous avez inclus les champs utilisateurs, définissez-les comme suit :
a) Sélectionnez Fichier > Notes > Modifier notes.
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b) Dans la boîte de dialogue qui s’affiche, entrez le texte de la note, sélectionnez 
Fermer, et puis sélectionnez Oui lorsque l’on vous demande d’enregistrer les 
modifications.

La note s’affiche au début de la dernière section du rapport.
4. Si vous souhaitez inclure un en-tête de rapport, définissez-le comme suit :

a) Sélectionnez Fichier > Notes > Modif. en-tête.
b) Dans la boîte de dialogue qui s’affiche, entrez le texte de l’en-tête, sélectionnez 

Fermer, et puis sélectionnez Oui lorsque l’on vous demande d’enregistrer les 
modifications.

Le texte de l’en-tête du rapport s’affiche dans la partie supérieure du rapport, sous 
le logo.

5. Pour modifier le logo affiché dans la partie supérieure du rapport, voir Logiciel 
OmniScan MXU : Manuel de l’utilisateur (P/N: DMTA011-01FR).

6. Si vous souhaitez enregistrer le rapport à un autre endroit que sur la carte de 
mémoire :
a) Connectez votre unité de mémoire USB à l’un des ports USB de l’OmniScan. 
b) Sélectionnez Fichier > Fichier > Stockage, et puis sélectionnez l’unité 

souhaitée.
7. Sélectionnez Fichier > Rapport > Générer pour afficher le fichier HTML du 

rapport sur l’écran de l’OmniScan (voir la Figure 8 à la page 26 et la Figure 9 à la 
page 27).

8. Avec la roulette de défilement, faites défiler l’écran pour voir l’ensemble du 
rapport. 

9. Sélectionnez Enreg. et fermer dans la partie inférieure de l’écran pour enregistrer 
le rapport et fermer le visualiseur de rapport. Le rapport est enregistré sur l’unité 
de mémoire sélectionnée dans le dossier \User\Report. 

10. Sélectionnez Fichier > Fichier > Enr. données pour enregistrer les données 
d’inspection dans un fichier .opd.
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Figure 8  Exemple d’un rapport HTML (partie 1 de 2) 
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Figure 9  Exemple d’un rapport HTML (partie 2 de 2) 
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